
You do n’t  have to b e a f anc y 
web developer to take advantage of 
Flash animations in your PowerPoint 
presentation. We’ll show you how it’s 
done.

When something goes wrong with 
your Windows boot files, it can really 
wreak havoc with your system. We’ll give 
you a few troubleshooting guidelines for 
both Windows XP and Windows Vista.

Finally, you’ll want your website 
visitors to stick around and read the 
great information on your web page. But 
if the text isn’t legible, they won’t have 
the patience to stay. Use our typography 
tips to increase your site’s appeal.

Putting your training into practice.
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From the Editor

Give your audience the action they crave with 
a Flash-y animation

In a world in which it’s rare to see a static web page — yet common to see a boring slideshow 
— it’s likely that your website designers have some Shockwave Flash File (SWF) animations that 
you can snag to add some zip to your PowerPoint presentations. We’ll show you how to insert 
and take charge of them, as shown in Figure A, so they work perfectly and are at your disposal.

Prepare PowerPoint to use 
SWF files
Before you can insert or control SWF files, 
you need to ensure that PowerPoint is set up 
to handle the format. If it isn’t, you can easily 
download the controls you need.

To determine whether you can use SWF 
files:

1.		  Open PowerPoint to the slide on which 
you want to insert your Flash file.

2.		  Select View | Toolbars | Control 
Toolbox. (In 2007, go to the Developer 
tab’s Controls group. If you don’t see a 
Developer tab, click the Office button, 
click PowerPoint Options, and in the 
Popular section, select the Show 
Developer Tab In The Ribbon check 
box.)
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3.		  Click on the More Controls icon to 
expand the list of available items.

4.		  Scroll down and look for the 
Shockwave Flash Object, as shown in 
Figure B. 

5.		  If it’s listed, you can skip 
to the next section. If you 
don’t see the control, 
visit www.adobe.com/
products/flashplayer and 
download the free player. 

You may have to close and 
reopen PowerPoint to activate 

the control. If you’ve updated Shockwave 
from a previous version, you may have 
trouble getting a SWF movie to play. See the 
Adobe TechNote article at www.adobe.
com/cfusion/knowledgebase/index.
cfm?id=tn_12727 to fix the problem.

An animated SWF file adds 
impact to any presentation, 

especially when you can play, 
pause, or rewind it.

A 	

http://www.newhorizons.com/content/coursecatalog.aspx?keyword=PowerPoint%202007%20-%20Level%202
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the SWF file you wish to insert, as 
shown in Figure C.

7.		  Close the Properties sheet and 
view your slideshow to ensure the 
movie plays correctly. 

At this point, you may wish to embed 
your movie. To do so, simply reopen the 
Properties sheet, set the EmbedMovie 
property to True, and then close the 
Properties sheet.

Take control of the SWF 
playback
Now that your movie is in place, you 
can allow it to play as soon as your 
slide displays by setting the Playing 
property to True. However, if you 
want more control over the movie, 
you can add a bit of Visual Basic 
script and a few colorful buttons 
that allow you to Play, Rewind, or 
Pause your movie. This can really 
come in handy when you need to 
address an audience question or 
replay the movie a second time.

I can’t control my movie!  Some 
versions of Flash allow developers to 
disable the play, pause, and rewind 
navigation commands. If you use a movie 
file secured in this manner, the action 
buttons described in this article won’t 
work. If you know the Flash developer, 
however, you can request a navigable 
version of the file.

Plan your file’s resting 
place
Now that PowerPoint is able to play SWF 
files, you must decide where to store the 
file permanently. 

•		  If you plan to play your 
presentation at various locations, 
you can store it on the web and 
link to it there. 

•		  On the other hand, if you want 
to use the presentation solely on 
your computer, simply place it in a 
folder and use that path. 

•		  You can also embed the file, which 
increases the PowerPoint file’s size, 
but avoids the need to keep track 
of multiple files. 

Whichever method you choose, note the 
path to your SWF file.

Insert the Flash file
Inserting a Shockwave Flash Object is 
straightforward. Just navigate to the slide 

on which you want the object to appear, 
and follow these steps:

1.		  Once again, click on the More 
Controls icon on the Control 
Toolbox toolbar and select 
Shockwave Flash Object, as shown 
in Figure B.

2.		  When the pointer changes 
to crosshairs, click and drag a 
rectangle to house your SWF 
movie. (You can resize it later.)

3.		  Right-click on the placeholder that 
appears, and select Properties. 
Click on the Alphabetic tab if 
necessary.

4.		  Note the text shown in the (Name) 
property text box — you’ll need 
it later. For instance, ours is 
ShockwaveFlash1. 

5.		  Set the Playing property to False by 
selecting it from the dropdown list.

6.		  Click in the Movie property field 
and enter the URL or pathname for 

If the Shockwave Flash Object item appears in the More Controls list, your 
version of PowerPoint is already set up to play SWF files.B 	

C 	
Tell PowerPoint where 
to find the SWF file by 

entering the pathname 
or URL in the Movie 

property text box.
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Object we noted earlier. (We used 
ShockwaveFlash1.)

5.		  After you enter the code, save your 
work and close the VBE.

Each Sub line creates and names a new 
macro that you’ll use later to make 
your movie play, pause, or rewind on 
command. For instance, Sub PlayShock() 
created a macro named PlayShock 
that, when activated, plays your 
ShockwaveFlash1 movie.

Check your macro security settings: 
The VB code creates macros that 
PowerPoint may block depending on your 
current security settings. To adjust them, 
select Tools | Macro | Security. (In 2007, 
go to the Developer tab, and in the Code 
group, click the Macro Security button.)

Create the control buttons
With the code in place, all that’s left to 
do is to create the control buttons on our 

slide and assign the appropriate code to 
each one.

1.		  On your movie slide, select Slide 
Show | Action Buttons.

2.		  Select Action Button: Custom 
button (the blank square).

3.		  Click and drag a rectangular button 
on your slide where you want the 
Play button to sit. When you release 
the mouse button, the Action 
Settings dialog box appears.

4.		  On the Mouse Click tab, select Run 
Macro, and then select PlayShock 
from the Run Macro dropdown list 
and click OK.

5.		  Right-click on the button you just 
created and select Add Text. 

6.		  Enter Play and click away from the 
button.

Adapt for PowerPoint 2007: In 2007, 
you need to insert a shape for your action 
button first; just go to the Insert tab, click 
the Shapes button, select a shape you 
want to use, and then click and drag the 
shape onto your slide. Then you can select 
the shape and click the Action button in 
the Insert tab’s Link group to open the 
Action Settings dialog box. From there, 
you can set up your macro to run just as 
you would in earlier versions.

Your button is ready to use, but you may 
wish to format it to match your slide. 
Right-click on it and use the Format 
AutoShape dialog box to change its 
appearance. Our finished button is 
shown in Figure D. 

Repeat the process for the 
PauseShock and RewindShock macros. 
When you’ve finished, you should have 
three buttons on your slide, as shown 
in Figure A. Now, when you run your 
slideshow, you can use the buttons you 
just created to play, pause, and rewind 
your movie to your heart’s content.

Business skills for the new world of work
In business today, productivity is key to your success. Whether that means setting up 
projects for success, forecasting and analyzing trends, or managing critical business 
information, it is vital that you have the skills to work at peak performance. You already 
know how to use Microsoft® Office System applications. New Horizons offers Microsoft 
Business Skills Series Courses to teach you how to use those applications to more effi-
ciently manage, work with, and prioritize information to make better decisions. Go to 
www.NewHorizons.com for information on courses that cover topics such as:
§	4003 Summarizing Microsoft Office Excel 2003 Data to Make Better Business 

Decisions
§ 4005 Beyond the Spreadsheet: Managing Financial Information Using Microsoft 

Office Access 2003
§	4007 Creating Effective Presentations Using Microsoft Office PowerPoint 2003 

Let VB code do all the work
To create seamless navigational controls 
for Flash movies in PowerPoint, you need 
to enter a few lines of VB code into the 
Visual Basic Editor (VBE). 

1.		  Choose Tools | Macro | Visual 
Basic Editor (or press [Alt][F11]) to 
launch the editor. (In 2007, go to 
the Developer tab and click Visual 
Basic in the Code group or use the 
shortcut key.)

2.		  In the VBE, choose Insert | Module 
and type the code in Listing A into 
the new module.

3.		  Replace all instances of SlideX 
with the number of the slide on 
which you’ve inserted your movie 
(for instance, Slide2, in our sample 
presentation).

4.		  Replace all instances of 
ShockwaveFlashName with the 
name of your Shockwave Flash 

Mimic the controls on a DVD 
player to give the audience a clear 
picture of each button’s purpose.

D

Listing A:
Code to control a Flash movie in 
PowerPoint
Sub PlayShock()

	 SlideX.ShockwaveFlashName.Play

End Sub

Sub PauseShock()

	 SlideX.ShockwaveFlashName.StopPlay

End Sub

Sub RewindShock()

	 SlideX.ShockwaveFlashName.Rewind

End Sub

http://www.newhorizons.com
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Troubleshoot startup problems and program 
errors with an all-in-one configuration tool

It may — or may not — surprise you that a simple act like installing a new application on your computer can 
bring it to a screeching halt, or at minimum cause various programs errors. That’s because Windows relies on files 
in the boot sequence to load properly, and if a program corrupts one of them, your system suffers from booting 
and program errors. Fortunately, you can tackle these problems by using the System Configuration Utility 
(Msconfig) to troubleshoot virtually any system configuration problems you may encounter.

Get started with the tool 
that offers so much
The System Configuration Utility 
lets you temporarily change the way 
Windows starts. For example, on x86-
based computers, you can use this tool 
to disable 16-bit startup applications 
specified in the WIN.INI and SYSTEM.INI 
files. To get started with Msconfig:

1.		  Log on as an administrator. 

2.		  Launch the System Configuration 
Utility by selecting Start | Run, then 
typing msconfig in the Open text 
box; press [Enter]. 

The System Configuration Utility 
provides several configuration tabs, 
which we’ll examine individually.

Pick your start options
When you configure the General tab, you 
can start Windows in one of three startup 
modes: Normal, Diagnostic, or Selective.

Go about your Normal 
business
If you select Normal Startup, all device 
drivers and services are loaded. This is 
equivalent to selecting Start Windows 
Normally on the Windows Advanced 
Options Menu that appears when you 
press [F8] during startup.

Choose “Safe Mode” before 
you reboot
Select Diagnostic Startup when you 
want Windows to start in Safe Mode with 
only basic device drivers and services 
active. When you select this option, the 
System Configuration Utility disables 
most services and you may not be able to 
run certain Computer Management and 
Control Panel tools. Once you’ve selected 
this option and clicked Apply, Windows 
prompts you to restart your computer. 

Benefit: After the computer 
restarts, the System Configuration 

Related Courses
•	  	 2285 Installing, Configuring, and Administering 

Microsoft Windows XP Professional

Utility launches automatically so 
you can selectively enable or disable 
options on the other configuration tabs.

Disable programs and services
If you choose Selective Startup, you 
can enable or disable programs and 
services listed in the SYSTEM.INI, WIN.
INI, BOOT.INI, Startup, and Services tabs. 
Deselecting a check box under Selective 
Startup disables all entries 
in the corresponding tab. 
You can also enable or 
disable individual entries 
on each configuration tab. 

As was the case 
with selecting Diagnostic 
Startup, choosing 
Selective Startup and 
clicking Apply prompts 
you to restart your com-
puter. After the computer 
restarts, the System 

Configuration Utility launches auto-
matically so you can enable or disable 
options on the other configuration tabs.

Take a beeline to System Restore
Before you begin a troubleshooting 
session, you can use the System 

I n f o r m a t i o n  S y s t e m s  P r o t e c t i o n

http://www.newhorizons.com/content/coursecatalog.aspx?keyword=2285%20Installing
http://www.newhorizons.com/content/coursecatalog.aspx?keyword=2285%20Installing
http://www.newhorizons.com/cisco-guaranteed-to-run.aspx
http://www.newhorizons.com/content/pressReleases.aspx?id=2264&sub=3&did=125&more=1
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Configuration Utility to initiate a System 
Restore operation. To do this, click the 
General tab, and then click Launch 
System Restore. Then, follow the 
prompts to create a restore point.

Restore a CAB file
Finally, with the General configuration 
tab you can restore an individual file 
from a cabinet. This is very useful if you 
know a specific file is corrupt and you 
want to extract it from a cabinet file and 
restore it to your hard drive. 

When you click Expand File, you 
can browse for the file you want to 
restore, the source location containing 
the cabinet, and the destination loca-
tion for the file. 

Configure the SYSTEM.INI 
and WIN.INI tabs in XP
On these two configuration tabs, you can 
enable or disable services and startup 
programs meant for earlier versions of 
Windows. Windows XP doesn’t require 
either the SYSTEMROOT\SYSTEM.
INI or the SYSTEMROOT\WIN.INI files. 
These files are maintained only for 
compatibility with older software. 
Windows uses the SYSTEM.INI file to 
configure system information for drivers 
and services. Windows uses the WIN.INI 
file similarly for applications.

Sometimes changing the order in 
which the items in the SYSTEM.INI and 
WIN.INI files load is enough to solve a 

startup problem. To change the order, 
select the item from the list and click 
Move Up or Move Down, as appropriate.

Modify bootups with the 
BOOT.INI or Boot tab
The BOOT.INI configuration tab in XP lets 
you configure a number of boot options. 
When you enable a specific boot option, 
you add it to the boot path in the [operating 
systems] section of the BOOT.INI file.

In Vista, you can configure the 
same BOOT.INI tab options by using the 
Boot tab. However, Vista doesn’t use the 
BOOT.INI file and the loading process 
treats your configurations differently. The 
following list describes the boot options 
you can apply and their function:

•		  /SAFEBOOT. Forces a start in 
safe mode by using one of the 
associated parameters.

•		  /NOGUIBOOT. Disables the 
bitmap that displays the progress 
bar during a Windows startup.

•		  /BOOTLOG. Enables boot logging 
to a file called SYSTEMROOT\
NTBTLOG.TXT.

•		  /BASEVIDEO. Directs the operating 
system to use standard VGA mode 
for the installed video driver. If 
your new video driver fails to work 
properly, you can use this parameter 
to start the operating system. You 
can then remove, update, or roll 
back the problem video driver.

•		  /SOS. Displays the name of each 
device driver as it loads. When a 
normal startup fails, you can use 
this boot option to determine 
which driver is failing to load. 

XP only: You can validate the 
integrity of any boot paths by clicking 
Check All Boot Paths.

Vista only: To make any of the 
standard or advanced changes perma-
nent (we’ll look at advanced settings 
next), select the Make All Boot Settings 
Permanent check box.

Troubleshoot with Advanced 
settings
Clicking Advanced Options lets you 
select any of the following:

•		  /MAXMEM=. Specifies the 
maximum amount of RAM that 
Windows XP can use. Use this 
parameter to confirm a faulty 
memory chip.

•		  /NUMPROC=. Allows you to force 
a multi-CPU system to use only the 
quantity of processors you specify.

•		  /PCILOCK=. Stops the operating 
system from dynamically assigning 
hardware input and output, and 
interrupt request resources to 
PCI devices. Allows the BIOS to 
configure the devices.

•		  /DEBUG=. Loads the Windows 
kernel debugger when you start 
Windows.

Eliminate problem-
causing services
On the Services configuration tab, you can 
enable or disable specific services. If you 
select the Hide All Microsoft Services check 
box, you can isolate third-party services to 
see if they’re causing a startup problem. 
Certain applications run as services. 
Problems with these applications might 
prevent you from starting Windows 
in normal mode. You can use System 
Configuration Utility to disable a service 
and verify that it’s the problem. 

Ditch the Startup programs
You may find that the culprit is a program 
that starts automatically. You can enable 
or disable startup programs on the 
Startup configuration tab. 

Vista gives the boot to the 
.INI tabs
Windows Vista uses the Windows Boot 
Manager to boot up instead of the 
Boot.ini, System.ini, and Win.ini files. 
The Boot Manager chooses which boot 
application to use — the standard app is 
the Windows Boot Loader.

Windows Boot Loader in turn 
accesses the configuration files 
stored in the Boot Configuration Data 
(BCD) file called the BCD registry file. 
Because of this significant change with 
the way Vista boots, the .INI files you 
can configure in System Configuration 
in XP simply don’t exist in Vista.
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great online. Often, the difference 
comes from subtle character 
spacing issues. So once you find a 
font you like, try out several similar 
ones on the screen. You can use 
the CSS font-family property to 
specify your first, second, and third 
(etc.) choices.

•		  Sans serif fonts are usually easier 
to read than serif fonts, and they 
tend to look bigger. This is one 
good reason to specify some fonts 
in your style code, since browsers 
often default to serif fonts.

Tip: Avoid mixing serif and sans serif 
fonts; the transition between reading 
such different types of fonts can slow 
down a reader.

Not all sans serif fonts are 
created equal
Just because a font is sans serif doesn’t 
guarantee legibility. And while the 

Don’t let common typography mistakes render 
your website virtually unreadable

Because it’s so easy to set fonts, background colors, and other formatting with CSS, some developers 
forget to choose this formatting carefully for legibility. Of course, it doesn’t matter how pretty the text 
looks if the reader can’t read it and leaves your site in disgust.

To make judging legibility even trickier, 
many developers don’t see the full 
text that will appear on the site, since 
the server-side code may generate it 
automatically. While a few test words on 
the site may look okay, bad formatting 
can cause readers to struggle while 
attempting to read whole paragraphs. To 
avoid these kinds of mistakes, it pays to 
know a few readability principles.

Key rules for readability
Readability refers to the ability to read 
all the text added to a web page. It’s 
much harder to read text onscreen 
than in print, so special considerations 
are required. For starters, consider the 
following guidelines:

•		  Don’t size text too small or too 
large.

•		  When possible, avoid specifying 
absolute font sizes, since they may 
prevent readers from making the 
text larger through their browser 

options. For example, font-
size:1.5em is better than font-
size:15px.

•		  Avoid overuse of type styles 
(e.g., bold, italic, all caps). A long 
paragraph in italics, for example, 
can be difficult to read.

•		  Don’t contradict common web 
practice in your use of type styles. 
For instance, avoid using colored, 
underlined text for anything that’s 
not a hyperlink.

•		  Be careful about placing text on a 
colored background.

•		  Choose common fonts that are 
easy to read on the web.

Choose appropriate fonts
Let’s take a closer look at font choice. 
Two key rules apply here:

•		  Some fonts that are good when 
you print a document aren’t so 

Related Courses
•		  Web Development with Cascading Style Sheets (Third 

Edition)

W e b  D e s i g n  &  D e v e l o pm  e n t

fancier fonts may look great in titles, they 
can be hard to read in paragraphs.

Let’s see what happens when 
we take even a great piece of text and 
put it onto a website with a poor font 
choice. We’ll make a CSS declaration 
specifying the Impact font (or any sans-
serif font if the client machine doesn’t 
have Impact):

<style>

	 .Impact {font-family: Impact,

	 sans-serif;}

</style>

Even great words lose impact 
with the wrong font
We’ll now apply this style to an excerpt 
from a famous speech Lincoln gave in 
October, 1854:
 
<p class=”Impact”>

	 When we voted for the Wilmot Proviso 

...

</p>

http://www.newhorizons.com/content/coursecatalog.aspx?keyword=Web%20Development%20with%20Cascading%20Style%20Sheets
http://www.newhorizons.com/content/coursecatalog.aspx?keyword=Web%20Development%20with%20Cascading%20Style%20Sheets


�
August 2009New Horizons Computer Learning Centers, Inc.

Apologizing to the great Lincoln in 
advance, we see that the results, as 
shown in Figure A, demonstrate that 
even the most cogent text in the world 
is virtually unreadable in the wrong font. 
Even if you find it not bad reading once 
you get into it, the mere appearance of 
such a font can intimidate readers from 
reading it at all.

More legible alternatives
Perhaps a better choice is to stick with 
a system font, such as Geneva (Mac) or 
Arial (Windows). These fonts aren’t only 
easier to read onscreen, but are also 
more likely to be installed on the user’s 
computer, thus reducing the risk of font 
substitution.

Be careful with colored 
backgrounds
Another area that’s important to watch 
out for is the colored background. As 
with most things on the web, less is 
more. Simply put, it’s hard to beat black 
text on a white background (or some 
shade of white) for legibility.

Certainly, depending on your 
site’s theme and purpose, you can still 
get satisfying results with other color 
combinations, as long as the contrast is 
adequate. And, in some cases, a client 
may demand a particular color scheme.

The trick to text on color: 
Make it bigger
One of the problems with any colored 
background is that it tends to make the 

text look smaller — especially if the text 
color is lighter than the background. For 
instance, suppose we apply the following 
style definitions to a page:

div {padding:1em;}

.withcolor {background-color:#880088;

	 color:#00FF00;}

.bigger {background-color:#880088;

	 color:#00FF00; font-size:1.3em;}

While the result in Figure B is 
okay in print, the second block of text 
is hard to read onscreen and looks 
surprisingly small — as if the text is 
dissolving into the color around it. The 
final block of text uses a larger font size 
to help overcome the readability prob-
lems caused by the background color.

Break up the text
Choosing the right font and size 
with which to format text is just the 
beginning. Also consider the way in 
which you place text on a web page. 
As a rule, it’s easier to read text that’s in 
narrow columns, rather than long rows 
that span the entire width of the page.

Create a column effect without 
multiple columns
Of course, this rule creates a little 
of a dilemma: You certainly don’t 
want readers to have to scroll up and 
down the website to read the sort of 
multiple column layout you’d see in the 
newspapers. That’s probably why such 

Some highly stylized fonts are hard to read if there’s a lot of text.A If you have to place text on a dark background, make it bigger.B
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layouts aren’t as popular as they were a 
few years ago.

However, you can still keep text 
from going all the way across. The one 
danger here is that this sort of format-
ting may not come out on a printer, 
which is why The New York Times offers 
a button to see a printer-friendly page.

Keep paragraph size small
A related issue is the size of the 
paragraphs. If you’re involved in writing 
any of the actual text for the web page 
(e.g., instructions for a web application), 
favor short paragraphs over long ones 
that seemingly never end. Otherwise, 
readers may lose patience and not even 
read what you wrote.

Don’t let your code get rid of 
all the white space either
Similarly, if your web application reports 
on data that users have entered, don’t 
get rid of all the white space. Some 
applications trim every bit of white space 
out of a string of text, assuming that 
every line break or indent is wasteful. 
In some instances, developers fail to 
encode text entered as a line break as 
an HTML break (<br>). The result is large 
blocks of impenetrable text.

Design for legibility
Even using techniques to increase 
text readability doesn’t guarantee the 
content will be entirely legible. Legibility 
has to do with the overall design of text 
on the page. The goal is to format and 

position the text so it’s easy for viewers 
to recognize the hierarchy of the content.

A matter of purpose
You’ll probably notice that some sites 
deliberately seek to be disorderly, jarring, 

or even annoying. Glitzy, flamboyant 
sites, may work as part of marketing 
strategy, or to appeal to specific 
audiences. But if your goal is to impart 
information, your best bet is usually to 
create an orderly page.

Graphic & Design eTips to Enhance 
Your Work
If you are an expert at what you do, then you 
want to sign up for FREE New Horizons Graphics & 
Digital Designer eTips. Each week you will receive 
expert advice from our experienced editors that 
will improve your productivity and enhance your 
work. Learn more about the applications you use 
everyday, including: Adobe Illustrator, Adobe 
InDesign, Adobe Pagemaker, Adobe Photoshop, 
Digital Photography and QuarkXPress. Imagine 
the possibilities with the skills you’ll gain!  
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